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About DUG Rock
DUG Rock is designed to allow petrophysicists to easily interpret lithologies from well logs
and generate end member trends for reservoir and non-reservoir lithologies. End-member
lithological trends have applications in forward modelling and interpretation of seismic
inversion products.

DUG Rock functions and features

Lithology and Fluid Picking

• DUG Rock allows you to pick lithologies based on information from the well log curves.
• Picks are populated into DUG Rock's crossplot charts and summarized into a spreadsheet-like table

for easy referencing of any specific pick.
• The quality of log data for a pick can be identified, allowing inclusion or exclusion at a later time.

Highlight Picks

• Too many picks from different well logs may cause confusion when viewing crossplot charts. The
Highlight Picks function allows you to select a pick from any crossplot chart and it will automatically
highlight its position on the well log curves as well as on the Data Summary Panel for easy reference.

Customization of Well Log Tracks

• DUG Rock allows you to display fully customizable well log tracks that are individually set to view
different curves in a standard form. This aids in lithology and fluid identification.

• DUG Rock allows you to manipulate well log tracks and well log curve display settings based on
different criteria.

Crossplotting and Automatic Lithology Trend Formation

• The four main crossplot charts show the picks (visually coded to show well and lithology), and the
trends calculated from the pick values.

• Lithology trends and standard deviation are calculated automatically when five or more picks are
made. The dashed lines are drawn at plus and minus two standard deviations from the mean. DUG
Rock also provides live update crossplotting and trend calculation as picks are interpreted.

• DUG Rock is built with a composite function so you can create composite trends by combining one or
more lithologies. In addition, you may import trends for reference and comparative displays or export
trends for input into DUG Distill.

• DUG Rock provides interactive changing of crossplot and trend display. The pick and trend colours,
appearance, and crossplot scales are customizable to your preferences.

• Synchronized navigation between logs, crossplots, and tabulated pick data for any number of wells.

Gassmann Substitution
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• Gassmann substitution adjusts the pick elastic properties to account for in-situ fluid, to correct back to
a specified reference fluid (usually brine).

• Velocity and density of the reference fluid are customizable.

Image Capturing Capability

• DUG Rock allows you to choose a standard size for images, particularly crossplots and well log
curves, for presentation and reporting purposes.

• Images can be saved as PNG or JPG file format.

Session Saving

• DUG Rock saves all data and display settings for future interpretation sessions.
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How to Use this Manual
This manual is a comprehensive user guide for the latest version of DUG Rock.

DUG Rock manual structure

This manual consists of 3 main parts:

1. Setup and Requirements — This section serves as an introduction to DUG Rock. It includes a brief
description of the features that this software has to offer, details on system and data requirements,
and how to download and install DUG Rock.

◦ Introduction
◦ Installation and Requirements

2. User Interface and Settings — In this section, we introduce you to the basic user interface, the
menu options, and various views that are available to display and configure your data.

◦ User Interface
◦ Menus and Settings

3. Tutorial Workflow — This section is a step-by-step guide of the common workflow to produce and
generate interpretation results in DUG Rock.

◦ Tutorial Overview
◦ Load Input Files
◦ Picking
◦ Crossplot
◦ Trending
◦ Save Session.
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Installation and Requirements
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Prerequisites

Well Log Curves

DUG Rock requires the following well log curves to provide a complete set of trends:

Mandatory well log curves:

• Depth – Measured Depth
• Compressional Sonic — e.g. DT, DTCO, DT4P
• Shear Sonic — e.g. DTS, DTTS, DTSM
• Density — e.g. RHO, RHOB, ZDEN.

Kelly Bushing and Water Depth are required to correct the MD (Measured Depth) to BML (Below Mud Level).

Optional well log curves (recommended but not essential)

• True Vertical Depth (TVD) — To output trends relative to true vertical depth in deviated wells
• Gamma Ray — For log navigation, lithology interpretation (e.g. GR, GMR, SGR)

If a complete set of well log data is available, DUG Rock will automatically display the following well log
curves in the Track Interpretation window:

• Caliper
• Spontaneous Potential
• Resistivity
• Neutron Porosity
• Photoelectric Effect.

The following well log curves can be used in reservoir trending if desired:

• Interpreted Porosity
• Interpreted Matrix Density.

Data Input File

DUG Rock requires well log data in Log ASCII Standard [LAS] Version 2.0 format. Other formats (LIS, DLIS,
etc.) are not supported by DUG Rock and must be converted to LAS before they can be used by DUG Rock.

Sample data including wells, picks and trends, can be downloaded from our website.

Data Output Files

DUG Rock produces two output files:
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• Session files with the extension *.rock.
• Trend files with the extension *.trend; these are used by DUG Distill, or by DUG Rock as reference

trends.
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System Requirements
DUG Rock is compatible with modern Windows, Mac OS X, and Linux operating systems.

The recommended system requirements for DUG Rock to achieve its optimal functionality are:

• 2 GB RAM
• 32-bit dual core 2GHz processor
• Windows (XP, Vista, or Windows 7); Mac OS X 10.5+; or modern Linux.
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Software Installation
When you purchase DUG Rock, we will send you an email with the download link, username
and password, and instructions to set it up.

Note: It is also important to keep the software up to date. You can download all software
updates from our website.

Installation steps

Windows (msi), Mac OS X (dmg), and Linux (rpm) packages are standard installer packages for those
platforms. You can usually install these packages simply by double-clicking on them.

If you downloaded the ZIP file for Linux, you can unpack it into any directory, and run the “rock” script inside.

Support

If you have questions or issues with the software, please contact support@dugeo.com.

Please include a description of the issue, along with any output that the program displayed on the console.
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User Interface

Page 14DUG Rock User Manual



Screen Display
DUG Rock provides an intuitive user interface to help you learn its features and functions.
See below for the screen layout and references to DUG Rock view panels and tabs.

For more information on the user interface, see:

1. Control Panel
2. Crossplot Panel
3. Menus and Settings.
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Using the Control Panel
The Control Panel is designed in tree structure for easy reference. Basic information such as
lithologies, wells and pick quality can be easily traceable in the Control Panel.

The tree structure of the Control Panel also includes check boxes to easily display/hide
information in the crossplots (see How to Display/Hide Information in the Crossplots).

Control Panel structure

The Control Panel tree consists of:

• Reservoir/Non-Reservoir Lithologies — See Creating New Lithology and Editing a Lithology to
create and edit a lithology from the Control Panel.

• Other Composites — See Composite Lithologies to compare and combine groups of lithologies into
composites to form a single trend.

• Gassmann — See Gassmann Substitution to learn how it works and how to apply it in DUG Rock.
• Reference Trends — See Reference Trends to import and remove reference lithology trends from

other projects for comparison.
• Wells — See Load Input Files chapter to learn how to load and configure wells from the Control

Panel.
• Fluids — See Creating a New Fluid and Editing a Fluid to create and edit a fluid from the Control

Panel.
• Pick Quality — See Pick Quality to include/exclude picks assigned to the quality in the crossplot

charts from the Control Panel.
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How to Display/Hide Information in Crossplots
Displaying/hiding information in crossplots is made simple with the Control Panel's tree
structure. This function is applicable to the following elements:

• Reservoir – Display/Hide Picks and(or) Trends
• NonReservoir – Display/Hide Picks and(or) Trends
• Wells – Display/Hide picks from the well
• Fluids – Display/Hide different fluids in crossplots
• Pick Quality – Display/Hide different pick quality in crossplots.

After customizing what is displayed or hidden in the crossplot charts, you may want to
Customize, Capture & Save Crossplot Charts for Presentation & Reporting.

Reservoir/Non-reservoir picks and trends

Picks and trends can be hidden or displayed by selecting/deselecting their check boxes in the Control Panel.

1. In the Control Panel, expand a Reservoir or Non-Reservoir tree to view the list of lithologies.
2. By default, all the non-reservoir lithologies are selected. Click the first row of check boxes to hide/

show all Picks or Trends, or click on individual check boxes to hide/show the selected picks or
trends. The first column of check boxes is for picks, while the second column is for trends. Crossplot
charts only display porous (reservoir) lithology picks and trends. The rest are hidden.

3. The colour of the lithologies can also be changed by clicking on the colour box beside the check
boxes, and selecting from the colour palette.
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Well picks

1. In the Wells tree, all the wells are selected by default. If you wish to view picks for only one well, clear
the other wells' check boxes. In effect, crossplot charts display only picks and trends for that one well.
Note: When you turn off or clear a particular well check box, the picks and trends of that well will not
be calculated and displayed in the crossplot charts.

2. The shape of each well's icon can also be changed by clicking the icon beside the check box and
selecting the desired shape.

Fluids and Pick Quality

Apply the same steps in Fluids and Qualities trees.

Whenever a check box is cleared, all picks and trends that are relevant to the fluid or quality category will be
hidden from the crossplot charts (see Pick Quality).
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Creating New Lithology
If the lithology is not available in the Lithology drop down list, you may need to create a new
lithology from the Control Panel.
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Create new lithology

1. To add a new lithology, right click on Reservoir or NonReservoir in the Control Panel and select Add
New Lithology.

2. Let's assume that you wish to create a sand reservoir lithology. Enter Sand as the lithology name at
the Name text box. The Grain section allows you to input grain properties. Enter the Vp, Vs and
Density values.

(The VP, VS and Density values for sand (quartz) are 5960 m/s, 3730 m/s and 2.65 g/cm3

respectively). Click OK to end the creation.
3. Then, perform picking in the Wireline Log Traces Panel.

Note: You may perform more than one pick for the same lithology at different depths.
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Editing a Lithology

Reservoir

For reservoirs,

1. Expand the Reservoir tree structure to reveal individual reservoirs in the Control Panel.
2. Right-click the reservoir that requires editing and select Edit Reservoir Properties. The Edit

Reservoir Lithology Properties dialog box appears.
3. From the dialog box, edit the name of the reservoir, the Vp, Vs, density and porosity of the reservoir.
4. Click OK to update the reservoir.

Non-Reservoir

For Non-Reservoir, only the lithology name is allowed for editing.
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Compute porosity

You may select a matrix density curve and/or a porosity curve as inputs to compute the porosity which will
display in the Data Summary Panel. This function provides flexibility for you to choose the matrix density and
porosity values based on your need, to use for Gassmann substitution.

Matrix Density can be inputted as a RHOMA data curve whereas Porosity can be inputted as a PHIT data
curve.

To use the Matrix Density and Porosity:

1. Select From Matrix Density Log and/or Porosity from Log, the Density text box under the Grain
Properties becomes unavailable. Then, click OK.

2. Select a well and right-click to Configure Well. In Data Curves section, do one or both of the
following:

◦ Select RHOMA for Matrix Density
◦ Select PHIT for Porosity.

3. Click Update to compute the porosity and it will reflect in the Pick Summary Table and Crossplot
Charts.
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Creating a New Fluid

1. Expand the Fluids tree structure to reveal individual fluids in Control Panel.
2. Right-click Fluids and select Add New Fluid. The Create New Fluid dialog box appears.
3. Enter name for new fluid and click OK.
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Editing a Fluid

1. Expand the Fluids tree structure to reveal individual fluids in Control Panel.
2. Right-click the specific fluid that requires editing, and select Edit Fluid Properties. The Edit Fluid

dialog box appears.
3. Edit the name of the fluid and click OK.
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Crossplot Panel
All lithology pickings in the wireline log traces will be displayed in chart form in the Crossplot
Panel.

There are four predetermined crossplot charts:

1. True Vertical Depth Below Mud Line (TVDBML) versus Compressional Velocity (VP)
2. Shear Velocity (VS) versus Compressional Velocity (VP)
3. Porosity versus Compressional Velocity (VP)

Page 26DUG Rock User Manual



4. Density versus Compressional Velocity (VP).

Trends are calculated based on the lithology pickings and eventually will form the trends in the crossplot
charts.
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View Settings
View Settings window allows the personalisation of the crossplot panel.

1. At Units, select if the preference unit of depth is in metres or feet.
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2. In the Crossplot Axes section, adjust the axes size, minimum and maximum, for any crossplot chart.
3. At Crossplot Content Sizes, adjust the minimum and maximum values to change the size of the

crossplots, which can be used to get fixed-size image for report.

4. Show/Hide trend standard deviations in crossplots.

5. Show/Hide Legend for easy reference.
◦ Show in XPlots — Legend appears in crossplot panel.
◦ Show in Chart — Legend appears in Track Interpretation window.
◦ Show Picks — Legend contains Picks information.
◦ Show Trends — Legend contains Trends information.
◦ Show Wells — Legend contains Well information.
◦ Split Res / Non Res — Legend is split to reservoir and non-reservoir.
◦ Width — Adjust the width size of legend.
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Menus and Settings
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File Menu
There are nine (9) options available in the File menu:

• New Session
• Recent Sessions
• Open Session
• Save As
• Save Current
• Export Single Well Session
• Export Picks
• Export Trends
• Exit.

New Session

A session is a collection of a series of processes that are stored during a saving action. This provides a
convenient way for you to store and retrieve the data in the application.

New Session serves as a quick removal of the existing session and load new session or wells into DUG Rock.
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1. In the File menu, click New Session.
2. An Info dialog box appears for confirmation to continue New Session process.

Note: Make sure you have saved the current session, if valuable, before selecting Yes. Rock closes the
current session once you confirm the process.

Recent Sessions

Recent Sessions option allows you to instantly trace recently opened sessions for quick loading.

1. In the File menu, navigate to Recent Sessions, which will display a list of recently-used sessions.
2. Select a session from the list to load.
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Open Session

Open Session allows you to retrieve the previous saved session for editing or reference. DUG Rock can
store picking and lithology information in session files with the file extension *.picks.

1. In the File menu, click Open Session. The Open Session dialog box appears.
2. Click the Look In drop down list. Select the session file (*.picks file) that you wish to open. Ensure

that the Files of Type is Rock Session (*.rock, *.picks).
You may clear the history by selecting the listed *.picks file in the History column and do one of the
following:

◦ Click Clear Selected to clear the selected file, or
◦ Click Clear History to clear all the listed files.

3. Click Open to open the session.
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Locate Missing File(s)

If the well log files (*.las) are moved, renamed or altered, DUG Rock will not be able to automatically locate
them. In such cases, DUG Rock will prompt the user to manually locate the missing files.

1. Click the Select File button to locate the missing file.
2. If the file has been moved, navigate to the new location, click on the file and click Open. The new

location of the file will appear in the New Path column.
3. Click OK to confirm and display the session.
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Save As

DUG Rock stores picking and lithology information in session files with the *.rock file extension by default.

1. In the File menu, click Save As. The Rock Save Session dialog box appears.
2. Click the Save In drop down list. Select the folder that you wish to save your session file in. Enter a

file name in the File Name text box (*.rock is recommended).
The History column on the right will list all the saved historical session files. You may clear the history
by selecting the file in the History column and do one of the following:

◦ Click Clear Selected to clear the selected file, or
◦ Click Clear History to clear all the listed files.

3. Click Save to save the session in *.rock or *.picks format.

Note: Well logs are saved separately in *.las files, and referenced by the session files when a session is
opened. Hence, files referenced during a DUG Rock session must be saved correctly. If the session file is to
be archived or transferred to another system, ensure that the associated well log files are saved as well.

Save Current

Save Current is a fast way for saving a currently open session.
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Export Single Well Session

Export Single Well Session option allows you to save a single well out into a new session.

1. In the File menu, click Export Single Well Session. The Rock – Export Single Well Session dialog
box appears.

2. Select the well to export and click OK and save the well session.

Export Picks

Picks and lithologies can be exported to a text format, which can then be used in most spreadsheet programs
or other software if required.
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1. In the File menu, click Export Picks as CSV. The Export Picks dialog box appears.
2. Click the Save In drop down list. Select the folder that you wish to export to. Enter a file name in the

File Name text box.
The history column on the right will list all the historical files. You may clear the history by selecting
the listed export picks file(s) in the history column and do one of the following:

◦ Click Clear Selected to clear the selected file, or
◦ Click Clear History to clear all the listed files.

3. Click Save to export picks to a text file.

Picks and lithologies can also be exported to *.las format.

1. In the File menu, click Export Picks as LAS. The Choose Output Directory dialog box appears.
2. Click the Look In drop down list. Select a location to save the directory. Enter a directory name in the

File Name text box.
The history column on the right will list all the historical files. You may clear the history by selecting
the listed export picks file(s) in the history column and do one of the following:

◦ Click Clear Selected to clear the selected file, or
◦ Click Clear History to clear all the listed files.

3. Click Open to export picks to LAS file.
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Export Trends

All the derived trends from the different lithologies produced by DUG Rock can be saved into *.trend file
format, which can then be used as an input file in other applications (eg, DUG Distill) for further litho-fluid
analysis and interpretation. It can also be used for trends comparison and for future reference in other
projects.

1. In the File menu, click Export Trends. The Save Trends dialog box appears.
2. Click the Save In drop down list to identify the folder that you wish to save in.

The history column on the right will list all the historical files. You may clear the history by selecting
the listed session file(s) in the history column and do one of the following:

◦ Click Clear Selected to clear the selected file, or
◦ Click Clear History to clear all the listed files.

3. Enter a name in the File Name text box with the extension *.trend.
4. Click Save.

See Appendix for the *.trend file format sample.
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Exit

The Exit option in the File menu allows you to quit from DUG Rock. DUG Rock system interface will close
when you select this option.

1. In the File menu, click Exit DUG Rock. An Info warning appears for confirmation to quit DUG Rock.
2. Click Yes.

Note: Make sure the session and wells are saved prior to exiting or you will lose all your work.
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Window Menu
There are seven options available in the Window menu:

• Track Interpretation
• Pick Summary Table
• Pick Info
• Trends Summary Table
• Additional Crossplots
• View Settings
• Biot QC Trends View.
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Track Interpretation

Track Interpretation opens the Navigation Panel and Wireline Log Traces Panel mostly for lithology picking
purposes.

For more information, see Track Interpretation.
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Pick Summary Table

This table displays information about the lithology pickings done in Track Interpretation, such as density, fluid
Vp, type of lithology and more.

See Pick Summary Table.
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Pick Info

The Pick Info window provides detailed information of the highlighted pick in the Wireline Log Traces Panel.
This section also displays Histograms for quality control of the end member picking.

There are four histograms available, which are P-slowness, S-slowness, Density and Porosity. These
histograms provide a visual representation of the distribution of the elastic properties over the blocked
interval, which allows you to determine if any anomalous data is being included in the upscaling of the
interval.
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A good end member pick will display a normal distribution in a bell shaped curve on the histogram. Normal
distribution means the distribution is concentrated in the centre and decreases on either side. The data in a
normal distribution has less of a tendency to include unusually extreme values in the evaluation.

Note: A pick must be selected in order to view pick info.

Trends Summary Table

Trends Summary Table provides the formulas behind creating trends in DUG Rock. This table shows only the
formulas for Standard Trends by default. Select Additional Trends to display more formulas for creating
additional trends in DUG Rock.

• Standard Trends include Vp, Vs, density and porosity.
• Advanced Trends include all the standard trends plus Pimp, Simp, Vp/Vs and v.
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Additional Crossplots

DUG Rock calculates trends for additional elastic properties from the four main trends and presents them in
the Additional Crossplots view.

Unlike the four primary plots, the four additional crossplots display trends in relation to burial depth (depth
below mudline).

1. P-Impedance vs. Depth
2. S-Impedance vs. Depth
3. Vp / Vs vs. Depth
4. Poisson's Ratio vs. Depth

These plots provide an intuitive comparison of lithology behavior with depth.
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View Settings

View Settings allows you to configure how the crossplot panel looks. Here, you can select the Units for the
data being displayed, the min-max of each crossplot axes and size of the plot (0 will be autofit), and whether
to show or hide legends.

For more information, see View Settings.
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Biot QC Trends View

The physical properties implied by extrapolated trends may become unrealistic, resulting in non-physical
lithologies.

Use this chart to evaluate the Biot coefficient for the depth range of interest. The Biot coefficient is determined
for each pick, and a trend is calculated for each set of picks. Trend lines are drawn for any "leaf" reservoir
trends (not composites).

Picks with a Biot coefficient greater than 1.0 are invalid / non-physical.
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The Biot Coefficient

Pore fluid pressures will reduce the effective stress supported by the rock mineral frame. The most common
form for the effective stress law is:

σe = σa - nPp

where

• σe is the effective stress
• σa is the applied stress on the rock surface
• Pp is the pore pressure.

The effective stress coefficient 'n' is also called Biot’s poroelastic term, or the Biot Coefficient. The Biot
Coefficient is calculated as:

n = 1 - Kd/Ko

where

• Kd is the dry rock bulk modulus
• Ko the mineral bulk modulus.

Because the rock modulus is usually much lower than the mineral modulus, n is often close to unity.

The valid physical range for the Biot Coefficient is from (total porosity) to 1.

• Values below Phi-T violate the Voigt bound.
• Values above 1 are not physically valid.
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Track Interpretation
There are two sections available in the Track Interpretation window:

• Navigation Panel allows you to zoom in the Wireline Log Traces Panel or to select a
particular mnemonic to display for quick reference.

• Wireline Log Traces Panel allows you to perform lithology picking in the well.

For more information on analysing each track, see Method of Analysis.
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Navigation Panel

Gamma Ray (GR) curve is the default mnemonic in the Navigation Panel. You may select a different curve
(other mnemonic) from the drop down list to display a clearer view of that mnemonic associated with the
Wireline Log Curves.

1. For a closer view of the curve in the Wireline Log Traces Panel, shrink the region box in green by
adjusting the top and bottom edges.

2. Click and drag the region box up and down to get to the preferred depth of the curve view.
3. If you wish to select a different curve, refer to the drop down list for the preferred curve view. By

default, the Gamma Ray (GR) curve is displayed.

Wireline Log Traces Panel

Wireline Log Traces Panel allows you to perform end members picks for reservoir and non-reservoir
lithologies. The lithology picks will be calculated and form trends.

1. Generally, four tracks are available in the Wireline Log Traces Panel. It provides visualization of the
well log data. See table above: each track has its dedicated mnemonic class(es) that is
predetermined by the system.
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2. Log curve values are reported below each track for the current cursor position.
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Wireline Log Traces Settings

Options are available for you to customize the wireline log curves to make each of the track more presentable
and informative.

To call out the options, you may right click on any region of each track. The wireline log curve options list
appears. You can control and change the setting for that particular track. Options available are New Track,
Track Properties and Delete Track.

New Track

To add a new track in the Wireline Log Traces Panel:

• Right-click on the track and select New Track. An additional track is added on the right.
• Right-click and select Track Properties to configure and display curve in new track.
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Track Properties

To customize the wireline log curves (track) settings:

1. Right-click on the track and select Track Properties to customize the track settings.
2. The Track Properties dialog box appears. This dialog box has three sections: Track, Template

Settings and Current Curves.
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3. Track Section — This section allows you to alter the track title, scale format and the range of the
selected track.

◦ To change the track Title, enter a name in the Title text box and click Apply. The name
displays underneath the selected track in the Wireline Log Traces Panel.

◦ For resistivity data, the Scale Format is defaulted to log. Others are defaulted to linear. You
can change the scale format to be either linear or log (logarithmic), if necessary. Click Apply
to change the scale format.

◦ To change the track Range, select from the list the track scale range that is appropriate. Click
Apply to confirm. The selected track scale is standardized across all the curves in the
selected track.

◦ For Manually Scale All option, enter minimum and maximum scale values into the numeric
boxes. If you wish to reset the values to its original values, click the Reset icon. Select the
check box to flip the grid's scale.
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4. Template Settings Section — The Template Settings section displays the dedicated mnemonic class
for each track. This section offers you the flexibility to set the mnemonic class(es) for each track in the
Wireline Log Traces Panel and to set the plotting in crossplot charts. You may add or remove the
class display in the selected track.

◦ To add a Class, click the Add icon. A blank drop down list appears. Click the drop down list to
select a class in which you wish to display the curve in the track and click Apply to confirm.

◦ To delete a Class, click the Remove icon next to the class that you want to remove in the
Template Settings section and click Apply to confirm.
You have to save the session whenever you add or delete a class as the change of the
Template Settings will only take effect when you re-open the saved session.

◦ To change the Option, there are three options available:
1. ALL - selected by default, as this results in plotting all traces (picks) in that class.
2. FINAL - only the last trace (pick) of that class will be plotted in crossplot charts.
3. STAGES - pick a number and that number trace (pick) of that class will be plotted in

crossplot charts.
Click Apply to confirm.
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5. Current Curves Section — This section displays all the curves in the selected track. You may add or
remove other curve(s) in the selected track.

◦ To add a curve, click the Add icon in Current Curves section. The Execution Results list
appears. Double click to select the curve that you want to display together with the current
curve in the selected track. The selected curve is added in the Current Curves section. Click
Apply to confirm.

• To delete a curve, click the Remove icon next to the curve that you want to remove. Click Apply to
confirm.

• To change the colour of the curve, click the Colour button to select the colour from the list.
Alternatively, you may click ... to select more colours from the colour palette. Click Apply to confirm
the colour.

Delete track

To delete the wireline log traces (track):

1. Right-click on any region of the track that you wish to delete.
2. Select Delete this track option to delete the track.

Note: You can only delete one track a time.
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Zooming in and out from the Navigation Panel

Wireline Log Traces Panel can be zoomed through reference curve in the Navigation Panel. To zoom, do one
of the following:

• Zoom In Wireline Log Traces — Point to the bottom or upper edge of the reference curve green
box. Pull the bottom and/or upper edge to adjust to a smaller green box.

• Zoom Out Wireline Log Traces — Point to the bottom or upper edge of the reference curve green
box. Pull the bottom and/or upper edge to adjust to a bigger green box.
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Pick Summary Table
When picks are performed in the wireline log traces, the picks data will be tabulated in the
Pick Summary Table. You are allowed to change the lithology, fluid and qualities of the picks
in the Pick Summary Table. Other values tabulated are fixed and cannot be changed in the
Pick Summary Table.

To change the lithology, fluid and quality types in the Pick Summary Table:

1. Ensure the Picking Enabled function is activated in the Track Interpretation window.
2. Click the selected Lithology, Fluid or Qualities. A drop down list appears.
3. Select the option from the Lithology, Fluid or Qualities drop down list.

Quality options

Quality options allow you to decide on the level of confidence you have in the elastic properties across a
blocked interval. The Quality option is defaulted to Good which is in green. The selected Quality option for
the pick will automatically be displayed with the assigned colour in the crossplot. You can choose to display/
hide picks for a particular quality from the Control Panel (see How to Display/Hide Information in Crossplots).

To change the Quality option:

1. Click the Quality drop down list to select the quality option e.g. None, Missing, Questionable, OK,
Good for the Compressional Velocity (Vp) , Shear Velocity (Vs), density (ρ) and porosity (φ). Select
<<A>> in the quality option for missing porosity. The quality option is only applicable after picking.

2. There is a specific colour assigned to each Quality option. The colour assigned cannot be altered.
See below for a list of assigned colours and symbol to the corresponding Quality option. This is
displayed in the Picking section:

◦ None – Black
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◦ Missing – Blue
◦ Questionable – Red
◦ OK – Yellow
◦ Good – Green.

For more information, see also Pick Quality.
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Actions Menu
There are two options available in the Actions menu:

• Capture Image
• Clear Selection.

Capture Image

Capture Image option allows you to capture the images in a standard and presentable format for reporting.
You can produce a better quality report by using this option to capture standard images. You can save the
image in either PNG or JPG format. It is recommended that the image be saved in PNG format to take
advantage of higher resolution image and smaller file size.

1. Click the Capture Image icon.
2. Hover the mouse over an area of the display that you wish to capture. The currently selected area will

be shadowed. To increase the selection to include surrounding panels, press the space bar or
PageUp. When satisfied with the selected area, left click or press Enter to capture the image.

3. The Save Image to File dialog box appears.
4. If you wish to cancel the saving process, press Esc or Cancel the Save dialog box.

For more information on capturing images, see Customize, Capture & Save Crossplot Charts for Presentation
& Reporting.

Clear Selection

The Clear Selection option unselects the current pick.
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Help Menu
There are three options available in the Help menu:

• Licence Manager
• Send Feedback/Ideas
• About DUG Rock.

Licence Manager

The Licence Manager can be used to activate your licence, view your active licences and configure your
network settings.

Refer to the Licensing chapter in the Insight manual for more information.
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Send Feedback/Ideas

If you have any ideas or feedback you would like us to know about, send them to us to help us improve DUG
Rock.
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About DUG Rock

This will display the software version number, copyright information and Insight's website address.

To make sure you have the most recent version, compare the version number with the version on our website.
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Tutorial Overview
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Workflow
The workflow diagram below depicts the common processes to be carried out step-by-step to
produce and generate interpretation results in DUG Rock. The subsequent sections will
describe the steps for identifying and interpreting the rock physics trends for probability
prediction of lithologies and fluids.

Note: Sample data including wells, picks and trends, can be downloaded from our website.

Click on the links below to jump to that particular section:

1. Launch DUG Rock
2. Load Well Data
3. Configure Well
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4. Identify End Member
5. Pick Lithologies
6. Display Picks in Crossplot Charts
7. Display Trends in Crossplot Charts
8. Customise, Capture and Print Crossplot Charts for Presentation and Reporting
9. Gassman Substitution

10. Composite Lithologies
11. Save Session.
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Launching DUG Rock

How to Launch DUG Rock for Windows

1. Double click the DUG Rock icon in the Desktop or Start Menu to launch DUG Rock. The DUG Rock
Launcher will appear.

2. Click on the Folder icon to select a project or create a new project.
3. Select the DUG Rock application.
4. Type or choose the maximum amount of memory that this application is allowed to use. By default,

500 Mb is selected and is generally enough.
Note: If you have a large number of wells or other data, you may see a message telling you that you
need to increase this number. However, avoid choosing an amount that is too large for your computer.
Running out of physical memory will make all applications run extremely slow. Please check with your
IT department if you are unsure.

5. Click Launch.

How to Launch DUG Rock for Mac OS X

DUG Rock can be installed anywhere on your system. Most people choose to drag it to the Applications
folder.

Page 67DUG Rock User Manual



Double click the DUG Rock icon in the Applications folder or your alternate installation location. The DUG
Rock Launcher will appear. Follow the steps above to launch DUG Rock.

How to Launch DUG Rock for Linux

1. Open the Main Menu on your task bar
2. Open the Office or Graphics sub-menu
3. Click DUG Rock. The DUG Rock Launcher will appear. Follow the steps above to launch DUG Rock.
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Load Input Files
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Load Well (LAS) Files
The first step when using DUG Rock is usually to introduce well data from LAS files. For
deviated wells, you should have a True Vertical Depth (TVD) curve in your LAS file before
loading.

How to Load the Input File(s)

1. From the Control Panel, right-click Wells to select Add New Well. The Open Well from LAS File
dialog box appears.

2. Click the Select File folder icon. The Open LAS File dialog box appears.
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3. From the dialog box, locate the well log file with a file extension *.las. Click the *.las file and then click
Open. The dialog box closes to make way for the Open Well from LAS File dialog box. All the well
curves in the LAS file will be displayed.
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4. To add or remove a well curve, click on the Add Row or Remove Row buttons respectively.
5. Verify the Units and Class column to ensure the designated class matches the curve data.
6. Click OK to open the LAS file.

Note: When there are two different depth curves available in the LAS file, you must assign the Class Depth to
the appropriate MD Curve. Then assign Miscellaneous to other depth curves as you cannot have more than
one class of depth.
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7. To see the list of wells that have been loaded, expand the Wells tree in the Control Panel.
8. Repeat the steps above to open multiple LAS files. All the selected well log files are displayed as

shown in the image.
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Configure Well
Three well log files are opened from the previous Load Well (LAS) Files section.

The next step is to configure the wells. It is good practice to first configure the well in DUG
Rock after loading the well log data.

Well settings

1. Right click on any one of the well log file in the Control Panel and select Configure Well.
2. The Well Settings window will appear.
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3. At Datum Settings, specify the Kelly Bushing Height (KB Height) and Water Depth. For example,
25.0m for KB Height and 70.0m for Water Depth.
All lithology trends are plotted below mud line (BML), therefore, both the KB Height and Water Depth
are required to correct the MD (measured depth) to BML.

Note: If your TVD curve is TVDSS, you will need to input your KB depth as 0.0. If your TVD curve is TVDKB,
then you will need to input the correct KB (or equivalent) depth.

4. In Data Curves, DUG Rock will auto-populate the curves according to your selection. The Configure
LAS File allows the reselection of curve class and units.
All the mnemonics that are specified in the LAS files are automatically listed within the Data Curves
section. You are allowed to change the mnemonic of the specific Class in the Data Curves section to
suit your analysis requirement.
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Picking
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Identify End Member
After the wells configuration, you can move on to the picking process. However, before the
lithology picking process is performed, you must determine the rock formation in a different
depth from an external source (for example, the drilling report). After that, identify and pick
the end members for reservoir and non-reservoir lithologies in the Wireline Log Traces
Panel.

An end member is the cleanest example of lithology (typically sand and shales) which is
identified in the lithological analysis. Ideally, an end member clean sand should have 100%
quartz based on mineralogy. Practically, however, this is not the case and a particular end
member lithology will represent the 'cleanest' picks of that lithology where log data is deemed
reliable. This means that within a given end member there will be a degree of mineralogical
variability, which could include variations in clay, cement and matrix minerals. Interpreting
'clean' picks involves consideration of all relevant logs (including gamma ray, resistivity,
neutron, density, sonic and other relevant logs). Often a simple gamma ray cut-off is
insufficient.

Let's assume that the petrophysical analysis is carried out and an end member is identified
between 1,450 metres and 1,460 metres. Before the picking process is performed, you have
to adjust the reference curve to a size of approximately 100m in depth to facilitate the picking
process in the Wireline Log Traces Panel.
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How to Identify End Member in Wireline Log Traces

1. From the Control Panel, open the Window menu.
2. Select Track Interpretation. The Track Interpretation window will be displayed (see Track

Interpretation).
3. Click on the well tabs to view and configure the wireline log traces.

Page 78DUG Rock User Manual



Shrink the green box by dragging the top and/or bottom edges to a size of approximate 100m in depth.

Refer to the Wireline Log Traces Panel to see the wireline log curves being zoomed in to a more readable
data form.
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Method of Analysis
There are four tracks in the Wireline Log Traces Panel. By default, all tracks are displayed in
linear scale format except for the resistivity track which is displayed in logarithmic scale
format. However, you may adjust the tracks and the scale format from the track settings
based on your preference at a later time (see Track Properties).
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Track 1

Gamma Ray log is shown in the first track in the Wireline Line Log Traces Panel by default. Typically the log
is plotted on a scale from 0 to 200 with the units of API, but it is adjustable. Gamma Ray measures the natural
radioactivity and can be used to determine what types of rocks are present in the well. The gamma radiation
level shows increasing radiation to the right and decreasing radiation to the left. The characteristic of gamma
ray is associated with three components, namely potassium, uranium and thorium. For example, shale
contains more radioactive elements which emit more gamma rays. This is because radioactive potassium is a
common component in clay content and tends to absorb uranium and thorium, therefore its curve will tend to
shift to the right, whereas sandstone, which emits few gamma rays, will tend to shift to the left. However,
sandstone can also contain radioactive minerals such as potassium feldspar, clay filling or rock fragments that
cause it to have higher than usual gamma readings.
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Caliper log is one of the mnemonic classes shown in the first track, if selected. Caliper log is used to measure
borehole diameter and is normally used for quality control, to supplement other logs during the picking
process. Bad or poor hole areas can usually be determined if the caliper log has a high deflection.

Spontaneous Potential (SP) log is shown in the first track, if selected. SP is measured in millivolts (mV). The
SP log measures the electrical potential generated between the borehole fluid and the surrounding reservoir
rock and fluids. This can be used to identify permeable beds and determine the salinity of the formation water
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relative to that of drilling mud. For example, porous sandstone with high permeability will show large potential
deflection, relative to the impermeable shale, and the SP will remain unaffected in an impermeable situation.
The magnitude and the direction of the SP deflection will be very much dependent on the drilling mud used
(e.g. fresh water base mud or salt water base mud). If the drilling mud is more saline than the formation water
(Rmf > Rw), the SP will show a deflection to the right which is considered to be a positive deflection.
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Track 2

Resistivity logs are shown by default in the second track and are scaled in units of ohm-meters. This log is
presented on a logarithmic scale form. Resistivity logs measure the electrical properties of rock and fluid.
When a formation contains hydrocarbon, its resistivity will be high and will show a deflection to the right,
whereas when the formation is porous and contains brine water, its resistivity will be low and will show a
deflection to the left. See image below of brine sand with low resistivity.
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Track 3

Density, Neutron and Photoelectric logs are displayed in the third track in the Wireline Log Traces Panel.
The crossover of the neutron/density logs can distinguish the reservoir or non-reservoir lithologies. For
example, shale will indicate a positive separation on neutron/density crossover (i.e. density log plots to the
right of the neutron log), whereas sandstone will indicate a clean negative separation on neutron/density
crossover.

The inclusion of the photoelectric (PE) log can provide an additional validation to the lithology interpretation.
For example, limestone will show no crossover on the neutron/density logs (i.e. neutron and density logs
overlie) due to its high matrix density. With the simultaneous consideration of photoelectric log, limestone can
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be easily recognized when the PE value shows about 5 barn/electron. See Common Logging Tool Response
for better interpretation.

Track 4

Sonic logs are shown in the fourth track by default to determine the porosity by measuring how fast sound
waves travel through rocks. Sound waves travel faster in rocks with low fluid content than those rocks with
higher fluid contents.
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End Member Interpretation
The availability of the relevant logs is essential for end member interpretation in DUG Rock.
You may not be able to get a good interpretation without involving relevant logs such as
gamma ray, resistivity, density, neutron, sonic logs and so forth. Therefore, the simultaneous
consideration of the relevant logs is important to get an accurate interpretation for end
member picking.

Note: The coloured blocks in the examples below are the end members picking. Different
types of end member are assigned to different colours. The picking process will be further
explained in Picking Lithologies.

Refer to Figure (a) at depth interval of 3230m to 3240m and Figure (b) at depth interval of 4210m to 4220m.
Both intervals have low gamma readings, which are 17.95 and 27.09 API respectively. These low gamma
readings indicate the presence of sandstone at these depth intervals. Resistivity readings are influenced by
variations in fluid content. Notice that in Figure (a), the resistivity logs show a very high resistivity and large
negative neutron/density crossover which contrasts with Figure (b). When there is high resistivity and large
negative neutron/density crossover, this generally indicates the presence of hydrocarbon.
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In comparison with sandstones, shaley sandstones have higher radioactivity because they contain a
significant quantity of clay. Thus, they have a higher gamma reading than clean sandstone but a lower
gamma reading than shale at 37.8 API. Another characteristic for shaley sand is that it has a small to
negligible neutron/density crossover.

By contrast, there is a sharp increase in gamma readings for shale, which in this case is 97.1 API. This is
because shale contains more radioactive elements. Therefore, its gamma reading is higher than sandstone.
The overlay of the neutron and density logs reflects their varying responses to the composition of the
sandstone and shale. The distinctions between shale and sandstone are that shale has high gamma ray
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readings and positive neutron/density crossover, whereas sandstone has lower gamma ray reading and
negative neutron/density crossover.
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Common Logging Tool Response
See the table below for the common logging tool responses for various lithology types to
allow you to identify and pick the end member effectively and efficiently. The logging tool
response varies according to the mineral content.
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Well Log Characteristics
Below are examples of the well log characteristics for reference.
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Picking Lithologies
Once you have identified the end members for the reservoir or non-reservoir lithologies, you
can perform the 'picking' process in the Wireline Log Traces Panel. The selected 'clean'
interval (end member) will be blocked, upscaled and the relevant properties (both mean and
uncertainty) over this interval will be recorded.

How to Pick Lithologies

1. Click the Picking Enabled check box.
2. Select a lithology from the Lithology drop down list for picking.

If the lithology is not available, you can Create a New Lithology.
3. Then, perform picking in the Wireline Log Traces Panel.

Note: You may perform more than one pick for the same lithology at different depths.
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4. Repeat the above steps to perform other lithology pickings.
5. Once picking for all identified lithologies in the well curves has been completed, clear the Picking

Enabled check box to end the picking.
6. Click on another well tab and repeat the above steps to pick relevant lithologies.

Note: Refer to Editing a Lithology to edit and delete a lithology.
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Example

This image shows an example of the end member interpretation. The straw coloured picks are the end
member sands and the blue picks are the end member shales. Before being used, each pick is upscaled and
averaged to become one point on the crossplots.
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Depth dependent end member elastic (lithology and fluid) property trends, based on available log data, are
derived along with their uncertainties. The solid fitted line is the mean trend, while the dotted lines on either
side capture two standard deviations of scatter.

The trends crossover at about a depth labeled Y metres. That means above Y metres the shale is softer than
the sand. Below Y metres, the shale is harder than the sand.
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Pick Quality
The Pick Quality tree allows you to include and exclude the picks assigned to the quality
from the trend calculations.

There are four parameters that can be assigned to quality:

• Compressional Velocity (Vp)
• Shear Velocity (Vs)
• Density (ρ)
• Porosity (φ).

For various reasons, one or more of the picks may not be behaving in a normal manner or in good quality.
Therefore, the use of various quality types can help you to distinguish poor picks from others. Turning off one
or more poor quality types of the picks will result in removing the poor quality picks in the crossplot charts, and
those poor quality picks will be excluded from the trends calculation. This will allow you to produce better and
more reliable trends.

The qualities can be categorized into five categories. You may select any based on your need:

• None
• Missing
• Questionable
• Okay
• Good

There are several ways to determine the quality types:

• Bad hole or large hole size (Caliper is a useful tool to determine the bad hole)
• One of the logging tools may not be functioning correctly
• Suspicious lithology – for example, different mineralogy.

You may see a better effect after removing those picks.
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To include or exclude the picks assigned to that quality from the trend calculation, select or deselect the check
boxes.
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Crossplot
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Display Picks in Crossplot Charts
As you perform picking in the Wireline Log Traces Panel, the pick is simultaneously
highlighted in a black highlight point and displayed automatically in the crossplot charts.

You may adjust the axis limits of the crossplot charts from the View Settings as described
below.
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How to Adjust Axis Limits on Crossplot Charts

DUG Rock automatically links the pick in the Crossplot Panel to the associated well and to where the pick is
located in Wireline Log Traces Panel. More information on the pick can be gained by viewing the Pick
Summary Table. For a more visible and less cluttered view on the picks in Crossplot Panel, you may adjust
the crossplot charts' axes.

1. From the Control Panel, open the Window menu and select View Settings.
2. In the Crossplot Axes section, enter the minimum and maximum values in the text boxes for the

appropriate axis. The changes will be applied on-the-fly.
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Trending
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Introduction to Trends
DUG Rock calculates trends from lithology picks using linear regression. A lithology requires
five or more picks to calculate the trend and standard deviation. The trend formulas are
displayed in the Trends Summary Table.

Trends Summary Table

1. From the Control Panel, open the Window menu.
2. Select Trends Summary Table.
3. In the table, select to only display Standard Trends or to include Additional Trends.

◦ Standard Trends include Vp, Vs, density and porosity.
◦ Advanced Trends include all the standard trends plus Pimp, Simp, Vp/Vs and v.

4. The formulas will be displayed accordingly in the table.
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Display Trends in Crossplot Charts and Save
Trends
Four primary trends are calculated for reservoir lithologies: TVDBML vs Vp, Vs vs Vp,
Porosity vs Vp and Density vs Vp.

Three trends are calculated for non-reservoir lithologies (the porosity trend is excluded).

Trends can be exported and used as input in other applications (see Export Trends), for
example:

• DUG Distill — Stochastic modelling and simulation
• DUG Insight — Model building.
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Crossplot charts

The trends are formed by regression analysis.

To view the formulas used to form these trends, open the Trends Summary Table (see Trends Summary
Table).

Crossplots and Trends Interpretation

There are several factors that influence lithologies and their trends:
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Compaction / Stratigraphic

As the depth of burial increases, compaction of the sediments generally occurs. The depth of burial of a
sediment increases with time and as the weight of the overlying sediments increases, the lower layer must
support the weight of the upper layer. This causes some of the liquid to be expelled and porosity will decrease
with depth. Consequently, both sonic velocity and density of a sedimentary rock generally increases with
depth. Therefore, in this case, a younger shale in the upper layer tends to have a lower bulk density and
velocity (both compressional and shear velocity), whereas an older shale, that is buried to a deeper level,
tends to have higher bulk density and velocity.

Over time, sedimentation differs due to changes in the environment of deposition, resulting in variations in
sedimentary layers. This image illustrates the comparison between Shale A and Shale B. Shale A is younger
than Shale B as it tends to have lower compressional velocity at the same depth in the TVDBML versus VP
crossplot. These two shales have different geological settings and depositional environments, which results in
Shale A having a lower velocity than Shale B at any given depth.

In DUG Rock, the reservoir lithology trends are formed based on a linear regression where its compressional
velocity varies linearly with density. In contrast, non-reservoir lithology trends are formed based on a non-
linear Density versus Vp (Compressional Velocity) equation:
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Density = a x Vpb

where a and b are constant, and Vp is compressional velocity.

This image illustrates the comparison of density relative to VP among shale, sand and shaley sand. Notice
that shale plots are at a higher density position, relative to Vp, than sand and shaley sand. This is because in
nature, shale tends to consist of minerals with a higher matrix density than quartz (the main constituent of
shaley sand and sand). This results in a higher density for shale compared to shaley sand and sand.
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Environment / Mineralogy

The environment of the deposition may affect the mineralogy of the various lithologies. For example,
glauconitic sandstone. Glauconitic sandstone is an authigenic sandstone which forms on the continental shelf
during a marine transgression, where sedimentation occurs at a slow accumulation rate. Glauconite contains
iron, which results in a higher density than a clean quartz-rich sandstone. Therefore, it plots at higher density
relative to velocity on the crossplot charts.
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Customize, Capture & Save Crossplot Charts
for Presentation & Reporting
There may be times when certain information from the crossplot charts is required for
presentation and reporting. In this instance, you may need to customize picks and trends,
capture and save the crossplot chart(s).
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Customize Picks and Trends View in Crossplot Chart

Picks and trends displayed in the Crossplot Panel can be filtered by adjusting the settings in the Control Panel
(see How to Display/Hide Information in Crossplots).
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Presentation / Reporting

You may use the Capture Image function to capture the Crossplot Charts, save the image into *.png and then
insert the captured image into your report or presentation slides. This allows you to capture a consistently
standard size of image for presentations and reporting.

Capture Image

1. In the Actions menu, click Capture Image. Alternatively, click on the camera icon at the top right of
the crossplot panel.

2. Point to any crossplot chart. Right click, press space or press Page Up to highlight all four crossplot
charts.
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3. Then left click or press Enter, the Save image to file dialog box appears.
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Save Crossplot Chart

4. Enter a name in the File Name text box. For example, crossplot_image.png. Select a location from
the Save In drop down list to save your image. For example, Rock_demo folder.

5. Click Save to store the image.
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Reference Trends
Reference Trends allows you to add reference lithologies for trends comparison. You may
add reference lithologies trends from other projects to the current project for comparison of
the compaction factor, environment factor, and the elastic properties of the same lithology
formation.

For example, assume we have Composite Late Cretaceous shale trend for project A and
another Composite Late Cretaceous shale trend for project B (which has been done). We
can then import Composite Late Cretaceous shale trend from project B into project A, and
compare the result. If the trends comparison turns out to be the same, we can conclude that
they are deposited in the same compaction factor, environment, and have the same elastic
properties.

Import Trends

1. Right click on Reference Trends and select Import Trends. The Import Trends window will be
displayed.

2. In the Import Trends window, select the trend file (*.trend, *.txt, *.asc, *.prn) and click Open.

3. Select which trends in the trend file you wish to import.
4. Click OK.
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The trends will be displayed in the Control Panel under Reference Trends. To display it on the crossplots,
select their check boxes.

Remove Trends

To remove all reference trends, right click on Reference Trends in the Control Panel and select Remove
Trends.

To remove individual reference trends, right click on the individual trends and select Delete Reference Trend.
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Trend Creation Properties

To view information of the trend, right click the trend and select View Trend Creation Properties.
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Gassmann Substitution
The main reason for carrying out Gassmann substitution is to obtain the depth-dependent
elastic rock property trends that illustrate how rocks behave elastically with depth. Gassmann
substitution removes the inherent scatter in rock properties caused by the variation in fluid
properties, by correcting the logs back to a known reference fluid (e.g. brine). The application
of Gassmann substitution helps in obtaining the variation in elastic rock properties with
depth, without the added variability due to changes in fluid type. This correction is important
in rock physics analysis and can be used to provide the interpreter with a tool for modelling
and quantifying various fluid scenarios with depth.

Theoretically, Gassmann substitution is used to calculate the rock properties at simulated in-
situ reservoir conditions. Gassmann fluid substitution involves the transformation of bulk
modulus from one fluid type to another, which means it models the changes from the original
fluid (usually involves gas, water or oil) to a reference fluid (usually an average brine) by
removing the original fluid prior to modelling a reference fluid. Replacement of gas or oil by
the denser brine increases the bulk density of the formation and sonic velocity. Therefore,
after the application of Gassmann substitution, the density and velocity of the reservoir
increases.
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How Gassmann Substitution works in DUG Rock

Before you begin Gassmann substitution in DUG Rock, you must determine the following four components
from the analysis of wireline log data:

1. Matrix Properties (Grain Properties)
2. Fluid Properties (Fluid VP and Rho)
3. Porosity
4. Reference Fluid (VP and Rho).
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Matrix Properties (Grain Properties)

Prior to applying Gassmann substitution, information on the matrix properties (grain properties) must be
available. Ensure the grain properties (VP, VS and density) of the reservoir are entered correctly. Refer to the
table below for common minerals matrix properties.
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In addition, you can select the From Matrix Density Log (e.g. RHOMA) and/or From Porosity Log (e.g.
PHIT) as inputs to compute porosity, if they are available. Data (Vp, Vs and ρb) will be obtained from the Pick
Summary Table to calculate the Saturated Bulk Modulus which eventually will be used to compute Gassmann
substitution. After verifying the matrix properties values, proceed to enter fluid properties.

Fluid Properties

Next, you need to know the bulk modulus and density of the pore filling fluids (fluid properties). The fluids
properties can be obtained and calculated using formation pressure, temperature, salinity and the fluid
properties equation, for example, Batzle and Wang (1992). See table below for common fluid properties.
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Porosity

After the matrix properties and fluid properties have been determined and entered into the Lithology Grain
section and Pick Summary Table respectively, DUG Rock will then automatically calculate the porosity of the
rock and derive the bulk modulus of the porous rock frame from the Pick Summary Table. Next, calculate the
reference fluid.

Reference Fluid

The reference fluid can be identified through the porosity, the matrix properties and the fluid properties of the
reservoir. You may enter the reference fluid, usually calculated from average brine properties of the area of
study. Then, apply Gassmann to substitute the reservoir fluid to the reference fluid.

As a result of Gassmann substitution, new density and velocity values of the reservoir will be derived and the
reservoir property trends will be corrected based on the reference fluid filling the pore spaces.

Gassmann Substitution – Input Fluid Properties

When there is hydrocarbon identified during the picking stage, Gassmann substitution proves to be a crucial
step to provide a trend that is independent of fluid type. Gassmann substitution cancels out hydrocarbon or
gas effect on well logs by correcting the log values back to a reference fluid (usually an average brine).
Velocity and density of the reference fluid is input in the Gassmann substitution section and generally is an
average of the brine properties of the area of study.

The default reference fluid VP is 1,635.25m/s and Rho 1.0g/cm3. Normally, these values are replaced with the
average fluid VP and Rho of brine sand based on the information that is displayed in the Pick Summary Table.
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How to Set VP and Rho Values for Gassmann Substitution

1. In the Control Panel, expand the Gassmann tree.
2. Manually calculate the Fluid VP and Rho average values obtained from the Pick Summary Table.
3. Enter the average value of the VP and Rho in the VP and Rho text box at the Gassmann

Substitution tree.

Gassmann Substitution – Apply Gassmann to Correct
Crossplot

After setting the VP and Rho values for the reference fluid, you may apply the Gassman substitution to create
new velocity and density parameters for the reservoir lithologies. DUG Rock Gassmann substitution's logic is
based on Gassmann's Theory.

Gassmann substitution carried out on sandstones generally tightens up the rock property trends, removing
scatter as a result of variations in fluid properties. This can also provide confidence in the calculated fluid
properties.
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How to Apply Gassmann Substitution

1. In the Control Panel, select the Gassmann check box to apply Gassmann Substitution.
2. See before and after Gassmann Substitution effect in the image below.
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Composite Lithologies
There may be a need to compare or combine groups of lithologies. If lithologies behave
elastically in a similar way with depth, then it may be necessary to generate a trend of
combined lithologies. DUG Rock provides a composite function that is capable of combining
several lithologies to form a single trend.

How to Create Composite Lithologies

You can create a reservoir or non-reservoir composite from the Control Panel.

1. Simply right click on Reservoir or NonReservoir, and select Add New Composite.
For other composites that do not fall into either category, you can create them in Other Composites.

2. Enter a name for the new composite lithology for easy reference and click OK. Let's assume that you
want to composite non-reservoir lithologies: enter a new composite name, for example, Composite
Shale.
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3. To add lithologies to the composite, right click on any other lithology and select Move to. Choose the
composite that you have just created.
Alternatively, you can also click and drag lithologies into a composite.

4. You can also add new lithologies to the composite. Right click on the composite and select Add New
Lithology to Composite.
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Save Session
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How to Save a Session
This is a crucial step. The Save Session function allows you to store all the activities
performed in DUG Rock at any time. All the hard work of identifying end members and
customizing picks and trends can be saved. Before saving the session, it is good practice to
first organize the location of the wells data files (*.las files) into one folder. The session that is
saved should be placed into the same folder to facilitate future reference. Once the session
is saved, any moved or redirected wells data files cannot be located by DUG Rock and the
files will have to be located manually.

1. In the File menu, click Save As. The Save Session dialog box appears.
If you have previously saved the session, click Save Current.

2. Select a location for the session to save in. Enter a name in the File Name text box.
3. You must ensure your session is saved in the same folder as your *.las files. To verify that your

session is saved in the same folder as your *.las files, click the Files of Type drop down list and
select All Files. DUG Rock will look for the *.las files in the same folder where you saved the session.

4. Click Save to store the session in the folder.

Page 133DUG Rock User Manual



Appendix
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Sample File Formats

Sample *.las File Format
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Sample *.trend File Format

Page 136DUG Rock User Manual



Acknowledgments
This product includes 3rd-party software, including:
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• Copyright (c) 2002-2004 JGoodies Karsten Lentzsch (http://www.jgoodies.com/)

JScience - Java Tools and Libraries for the Advancement of Science

• Copyright (c) 2006 - JScience (http://www.jscience.org/)

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 'AS IS' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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